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A STEP-BY-STEP GUIDE FOR SCHEDULING A 

CONSTRUCTION PROJECT IN CCS CANDY. 
Compiled and edited by Kobus le Roux (MBA, PrCPM, PMI-SP, A.A.Arb)   

WELCOME - How to approach the course and get the best results 
 

Introduction 
 

Hi, I’m Kobus and I’m glad you’re joining me on this journey to expand your  skills as a built-

environment practitioner. Thank you for trusting us with this responsibility and I’m sure our training 

will give you an edge and provide you with high-value skills that will further your career.  

 

Having the ability to schedule a project  accurately is one of the most important and critical skills that 

a project manager or built-environment professional must have. If you are managing projects in the 

21st century without this skill, you are going to be left behind.   

 

In this course I'm taking the complexity out of CCS Candy and I will show you step-by-step how to 

use the software to schedule a real project like a professional would. You can watch and learn as 

many times as you want and will quickly realize it's not that difficult. I also  share most of my 

personal, pro-scheduling tips with you. This is detailed, insider information that you will not find 

anywhere else. 

 

I’m a PMI Authorised Training Instructor having lectured part-time for the past 10 years in 

departments of Construction Economics and for students at the Business Schools  of Tertiary 

Institutions and PMI Accredited Training Providers. It means I’m a modern lecturer and a modern 

learner, as are you. 

 

A modern learner has no age limit or age requirement. It is someone li ving in the 21st century looking 

to increase their skills through a training regime or training course. Liv ing in the 21st century means 

you are, like everyone else, continuously overloaded with information. This adds to your credential of 

being a modern learner. We have only recently made the transition from the formal classroom into 

the online space. This transition comes with its own advantages and shortcomings. In my experience 

with modern learners over the past years, it’s important that we prime ourse lves, our actions and our 

expectations to align with this new way of learning, to ensure we get the true be nefits of online 

learning. 
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The modern learner’s guide to completing courses. 
 

On-demand online courses are a wonderful way of gaining skills, but it  can become a frustrating 

journey for some. To avoid this, here are some guidelines that will help you get the most out of this 

course: 

 

1. The normal approach of a busy 21st century professional is to rush into the course, cram in as 

much info as possible and get it done and dusted. This is great way of getting a certificate, a 

piece of paper to put on the wall, but you may miss out on the core skills and deep knowledge 

imparted by the course.  

2. As a result, try to take it easy. Approach the course in a structured way by booking your 

calendar in 1-2 hours sessions. Make sure there are no disturbances during this time. 

Approach it like you would a live training session. Switch your phone  off, make some tea, get 

your spouse or friend to look after the kids or your pets and dig into the training. You can 

schedule a few of these sessions in one day if you like, with breaks in between, or you could 

schedule it over the course of a week.  

3. Many instructional software training courses try to skim all the required knowledge on a topic 

from the beginning to the end by going into painful details, nuances, fluff and peripherals of 

the software early on in the course. This course is different. Our course is designed in a way 

that gives you valuable and core skills within the first 3 modules. After module 3, you will be 

able to use the software to schedule a project. From those core skills and early victory, 

students usually become hungry for more knowledge and that’s when we expand into the 

peripheral and advance skills of using the software. So, get excited already! 

4. As a result, it helps to take your time with the first modules and then you can speed up as 

your confidence builds and your knowledge and skills progress. 

5. Also note, because of this approach, we skip some of the fluff early on. But don’t worry, we 

will get to it. The course is comprehensive and as we progress, we touch on the all the 

functionalities. Don’t become anxious early on if you stil l wonder: “what does this button do”, 

or “how do I do that”, we will get to each of those items in due course.  

6. When you’ve completed the course, feel free to ask. One of the disadvantages of online 

courses is the fact that you cannot ask a question in the  moment. However, you can always 

note it, finish the course to ensure it’s not dealt with somewhere else and if not, feel free to 

contact the course leader and ask the question. That is part of what you pay for and I 

personally respond to your question @ training@lerouxconsulting.com.  

I hope you enjoy the course! 

Regards  

Kobus le Roux 

  

mailto:training@lerouxconsulting.com
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MODULE 1 - Explore and understand the CCS Candy interface 
 

Lesson 1 - Creating a new company / job / program 
 

Candy has got the following levels in terms of managing a program: 

 

 

 

You can set up multiple Companies.  Under each Company you can create multiple Jobs or projects.  

Usually, the Job level is where your pricing document or Bill of Quantities reside. For each Job, you 

can create a number of Programs.  

  

Company

Program 1 Program 2 Program 3

Job
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When you start Candy, you will be presented with the Company Manager Screen: 

 

To create a new Company:  

➢ Click on the Company tab and select Add a new company:  

➢ Type in the particulars of the company and click OK.  

➢ Double click on the company name to enter into a company. 

➢ Once you’ve entered into a company you will be presented with the Job Manager Screen.  

 

 

To create a new Job:  

➢ Click on the Job tab and select Add a new Job or 

➢ Right click on the existing job and select  Rename: 

➢ Type in the particulars of the Job and click OK. 

➢ Double click on the Job name to enter into a Job. 

 

  



 

CCS CANDY PLANNING  Page 6 

 
Copyright © by Le Roux Consulting. All rights reserved. This presentation or any portion thereof may not be reproduced or used in any 

manner whatsoever without the express written permission of the publisher. 

To create a new Program:  

➢ When you’ve entered into a Job 

➢ Go to the Planning Tab:  

➢ Click on the Program Manager Icon 

➢ The same process repeats itself. You can create new programs or rename the existing program. 

➢ Double click on a programme to open it. 

 

To navigate back to the Job or Company Manager:  

➢ Click on the Candy Button. 

➢ It will take you back to the Job Manager screen.  

➢ Click on it again and it will take you back to the Company Manager screen. 

 

 

 

Open a new Program:  

➢ Navigate to your program manager. 

➢ Double click on the First Programme to open it.  

 

When you open the program manager, Candy provides you with a first planning program. Double -click 

to open this program, the following customisation-screen is presented. Here you can indicate the 

program name, the start date, the start day of the week and how many working days your project will 

have per week. Click on OK.  
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Once set up, you can double-click on the program to open it. Please note, nothing on your screen will 

show until you select a view in the document manager. To know which program is currently open, you 

can always refer to the yellow bar next to the menu icons:  

 

 

 

For now, open up the default view by clicking on the Activity List/Barchart button 

 

This will open up the default, standard Barchart view. Have a look below where we define the various 

components of the interface. 

 

Lesson 2 - Getting familiar with the interface 
 

 

 

Ribbon / Tabs 

Tab Tools / Icons 

Table / Document View side 
Barchart Window side 

Table / Barchart divider Columns Records 
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Lesson 3 - Saving / Backup, duplicating your programmes in Candy 
 
Candy is a real-time database system and hence, as you work it writes and saves your data in real 

time. As a result, you cannot save your work as it’s always accessible.  With a lot of advantages, the 

disadvantage is that you have no undo button as with other Microsoft software.  

 

Therefore, you need to create regular duplicates of a program in the program manager or you  need to 

backup your programs as ccs files which can be imported in to the existing or other Jobs.  

 
To access this feature, open your Program Manager:  

➢ Right click on the Program you want to Backup. 

➢ This brings up a right-click menu.  In this menu, you can rename, duplicate, customise, delete, 

backup or recover programs. 

 
 

 

Lesson 4 - How to navigate and set your views 
 

When working with any planning software, it is helpful to understand that there is a lot of data fields 

available which, for practical reasons, cannot all be displayed at once.  As you plan and work on you r 
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schedule, many of these fields are populated automatically in the background. Having the ability to 

set up and navigate specif ic views of your data is usually the first priority in learning any new 

planning software. 

 

In Candy, these views are managed by  the Document Manager.  

 

 

The Document Manager can also be called the View Manager. The following screenshot is an example 

where we inserted only a few of the possible columns available to you when working on the program.  

It becomes a significant list and therefore, we need to have access to the Document Manager to limit 

and hide some of the available columns. In the example below all the data entry columns are shown in 

white and the non-entry columns are shown in grey.  

 

 

 

The Document Manager in Candy helps us to set up and choose the specific set of  columns we want 

to open up and work on.  These views can be customised and saved.  When you click on the Document 

Manager, the following default options/views are provided:   
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Once we select a view by double-clicking on it, Candy will open up the view and show the columns 

selected.  The default view is 1.1 and can also be selected using the Activity List/Barchart button 

 

 

 

To Customise views,  

➢ select a document in the document manager  

➢ and click on the Customise button on the bottom right.   

➢ The following screen is presented where you can choose which columns to show and which 

columns to hide.   

➢ Once set up, by clicking on OK, this view is automatically saved and available in all your 

programs in Candy. 

 

 

 

You can also customise a view by using the right click menu on any field.   

➢ After opening up any view, right click on a field.  
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➢ Go to the Add/remove columns line and click on it.  

➢ The same Column layout shown above will be opened and you can edit your v iew. 

➢ Once you click on OK, it will automatically adjust and save your view in the Document 

Manager. 

 

MODULE 2 – CPM Scheduling principles 
 

CPM is one of several related techniques for doing project planning.  It is a method of mathematical 

analysis and is generally applied to any approach used to analyse a project network logic diagram. 

 

The basic technique is as follows: 

 

1. List all the tasks required to complete a project  

2. Allocate the time each activity will take to complete  

3. Add dependencies or logic between the tasks, i.e. task 2 can only start after task 1 is 

completed etc… 

4. Add logical end points such as milestones, i.e. the project must be completed by X date or 

day X. 

Using all these values CPM calculates the longest path of planned activities to the milestones or 

end date of the project.  

 

Consider the following example project with tasks, interrelationships and durations: 
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Activity Required Predecessor Duration (in months) 

A (None) 5 months 

B (None) 1 

C A 2 

D A 3 

E A 2 

F C 3 

G D 4 

H B, E 2 

I H 1 

J F, G, I 1 

 

Let’s provide a PERT diagram using CPM and calculate the critical path. 

 

Follow the course video and see the steps to create the following diagram. 

 

 

 

We can now calculate the various paths or chains through the project. The longest path is 

through tasks ADGJ and it equals 13 months.  

 

Why is this important to understand? 

1. Candy uses the exact same CPM calculations when you schedule. Using a software program, 

we don’t have to do the calculations and adjustments manually. It ’s automated by the 
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software, but many users don’t grasp these fundamentals and hence, struggle with scheduling 

concepts when they use the software.  

2. CPM helps us to determine a project’s total duration. It is important however to remember that 

the duration is based on our assumptions on task durations and interdependencies.  

3. CPM determines the critical path. This helps us to focus our effort on the most important 

chain of tasks that is driving the end date of our project. Remember that this also enables us 

to see how the critical path changes during our project, once we start updating our progress. 

4. CPM helps us to determine by when resources or information are required in order to stay on 

track. 

5. CPM determines the variance between planned and actual progress. Th is helps us to make 

early decisions and proactively manage our project for better outcomes. 

6. CPM helps us to determine the individual and reciprocal impact of circumstances that cause 

delay to our end date. 

7. CPM provides us with accurate forward-looking capability and allows us to do forecasts and test 

what-if scenarios.  

 

MODULE 3 - Basic Scheduling technique in Candy 
 

Apart from understanding CPM scheduling fundamentals and other construction related operational 

skills, you basically need 4 main skills to compile a schedule in any planning software. These are listed 

below: 

 

(a) You must be able to add your WBS summaries, tasks and milestones.  

(b) You need to enter links or interdependencies between tasks ;  

(c) you must be able to create and assign resources to a task and;  

(d) you must be able to set up and adjust the project’s working calendar. 

 

In this course, I focus on these core skills early on, it allows you to obtain solid knowledge about the 

most important aspects of the software so you can start planning. From there we can expand into wider, 

practical applications and knowledge areas. In this next section then, I cover a step-by-step 

introduction so you can master the four cornerstone skills you need to create a functional Gantt char t 

in Candy.   

 

SKILL 1 - Adding new tasks - The 3 main task/data types: 
 

Three task / planning activity types 
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Summary tasks are your Works Breakdown Structure (WBS) headings or levels. We will explain this WBS concept 

in more detail in our case study example.  To create a Summary task: 

 

➢ Click in any available line in the Activity description  column 

➢ Type in your summary name. 

➢ Go the “T” of Type column and type in a level number from 0 - 9 

To create a Task: 

 

➢ Click in any available line in the Activity description column 

➢ Type in your task name. 

➢ Go the Durn / Duration field and type in a duration  that is more than 0 working days. 

 

To create a Milestone: 

 

➢ Click in any available line in the Activity description column 

➢ Type in your milestone name. 

➢ Go the Durn / Duration field and type a 0-duration next to your milestone name. 

Creating Space between your lines 

 

➢ Remember the CTRL+INSERT shortcut is a quick way to create space between your tasks, milestones 

and summaries. 

 

DO THIS: 

 

1. By clicking on various lines add a few summary tasks, milestones and normal tasks to get a feel 

for adding tasks in Candy and creating hierarchies.  
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SKILL 2 – Linking tasks, creating interdependence: 
 

Without a logical interdependence between tasks any Gantt Chart becomes a To-do list rather than a 

dynamic schedule.  

 

Typical logic in MSP for instance only allows 1 link and the 3 main types are as follows: 

 

 

 

 

 

 

 

Candy is a bit different from other scheduling packages in that it employs a double link system. You can use both 

a Finish-to-Finish (FF) and Start-to-Start (SS) link.   

 

LEADS AND LAGS 

Day 

1 

Day 

2 

Day 

3 

Day 

4 

Day 

5 

Day 

6 

Day 

7 

Day 

8 

Day 

9 

Day 

10 

          

          

 

 

 
 

Day 1 Day 1 

Day 1 Day 1 

2 Day Lead 2 Day Lag 
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Follow the video for a detailed explanation of the types.  

 

HOW TO: 

 

Link tasks and create interrelationships 

 

1. Create the following tasks “Excavate trench” and “Cast Concrete” 

2. Open up the Successor Activity # and Predecessor Activity # fields.  

 

3. Select both tasks by clicking on the record selector line of the first, holding down SHIFT and 

clicking on the record selector of the second task. 

4. With both tasks highlighted, right click on the record selector 

5. Go to Link 

6. Go to Link end to start and click on it 

 

 

 

 

You will see that both Succ Act # and Pred Act # are automatically populated and the two tasks are 

linked Finish-to-Start (FS). 
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To delete a link: 

1. Right click on the concrete task’s graphic in  the Barchart window side. 

2. Go to Delete Links 

3. Select the task you want to de-link. 

 

 

 

Have a look at the video where we explain a few additional methods of linking t asks as summarised 

below: 

 

Option 1 

➢ Link using your mouse on the Barchart Screen.  

 
 

Option 2 

➢ Link using the successor/predecessor columns 
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Option 3 

➢ Link Using the Activity Properties dialog. 

 
To open up the dialog, double click on the activity’s bar in t he barchart window. 

 

 
 

 
Option 4 

➢ Link Using the Right Click Menu options. 
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Option 5 

➢ Link Using the Right Click Menu options – Link Clipboard 

 
 
 

 

Creating different types of links.   

Although FS links are the most preferable in a construction schedule,  they aren’t always the most 

logical. For instance, in our example, once we have excavated  2 days’ worth of work on our trench, we 

could already start casting concrete in those sections. We don’t necessarily have to wait for the 

complete trench to be excavated before we start with the concrete.  

 

In such a case, we may want to use a Start -to-Start link, meaning Casting of concrete can start, after 

excavation to the trench has started. Or we can also use a Finish -to-Finish (FF). 

 

To create SS and FF links in Candy 

1. Double click on Activity 2 in the Barchart window to bring up the Activity properties panel. 

2. Click on the Predecessor and Successors tab. 

3. There you will find the Cast Concrete’s predecessor which is Excavate trench. 

4. If you add a 0 to the Lead field, you create a SS task. 

5. If you add a 0 to the Lag field, you create a FF task.  

6. If you add X number to these fields it simply depicts an SS or FF task + X days.  
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SKILL 3 – Adding Resources: 
 
There are 3 types of resources you can use in Candy: 

 

 

 

 

 

 

 

 

 

 

 

 

The following shows a typical example of how the different resource types are allocated and spread over a task’s 

duration: 

 

 

 

HOW TO: 

 

Create and Assign Resources 

 

DO THIS: 

 

1. Create the following mini schedule of a Fibre cable installation.  

 

ACTIVITY DESCRIPTION
ACTIVITY 

DURATION
RESOURCE TYPE RESOURCE NAME RESOURCE QTY

Pour Concrete in foundations 5 DAYS DAILY
CONCRETE 

LABOURER
1 Labourer 1 1 1 1 1

Pour Concrete in foundatoins 5 DAYS TOTAL
25MPA 

CONCRETE
25 m3 5m3 5m3 5m3 5m3 5m3

Install formwork to concrete 

slab
5 DAYS POOL

FORMWORK TO 

DECK
100m2 20m2 40m2 60m2 80m2 100m2 100m2 100m2 100m2 100m2 100m2

Strip formwork
1 DAY

POOL
FORMWORK TO 

DECK
100m2 0m2

RESOURCE SPREAD OVER ACTIVITY

DAILY 

TOTAL 

POOL 

These are resources that consume working hours like 
people and equipment and each resource is applied daily 
to the task 

These resources take a total value and spreads it over a 
task’s duration. Typically used for material where we 
have a quantity such as meters, number, kg, m2, m3 etc. 

Unique resources that take a total and pools it evenly 
over the duration up to the total value. Specifically used 
for Formwork  
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Resources can be created by clicking on the Resource Icon.   

 

 

This icon opens up the Resources Creation sheet 

 

 

 

1. We have 2 labourers Koos and Reggie who can work on this project. They are able to excavate 

5 meters/hour each.  Their standard rate is R35/h  

2. The Fibre duct and cable material cost R150/meter and we need to install 100 meters. Only 

Koos can install this cable and he can install 25m/hour.  

3. Enter the following resources and values in the Resource Creation Sheet: 
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Assign Resources 

 

1. Once you have created resources, close the Resource definitions window. 

2. Go to the Documents Manager 

3. Select Document number 4.2 Barchart with Resource Allocations 

4. Double click in the Resource Code field.  

5. This will bring up a resource dialog with all the created resources . 

6. You can now choose one resource from this list and select the green check mark to al locate it 

to the task. 
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7. Select Koos and Reggie for the first task and click on the green check to allocate.  

8. Remember to stipulate the No/Qty as Candy doesn’t allocate any value as a default. In this 

instance, we will use 1 of each resource.  

9. Allocate Koos and the Fibre material to the “Install fibre duct and cable” task. Adjust the 

quantities.  

10. The result will look like this:  

 

SKILL 4 – Setting up the project calendar. 
 

To access the Calendar Setup, c lick on the Calendar icon: 

 

 

This will open as follows: 
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Click on Tools.  This will open the menu from where you can select the year planner, add calendars, 

set the workday pattern or extend the calendar.  
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MODULE 4 – Scheduling the Case Study Project Step-by-Step in Candy 
 

Now that you have a basic understanding of the four main skills you need to compile a Gantt Chart in 

Candy, let’s put it to the test and add more skills by doing this practical case study project.  

 

Case Study Information 
 

 

 

• The project is set to start on 01 January 2019 

• The completion date is 29 March 2019 

• Your teams will work 5 days/week and 15 March 2019 is a public holiday.  

• There is subcontractor who will do the manhole installations, but they can only work on 

weekends. 

 

 

STEP 1 - Starting a new schedule / program and setting the start date 
 

DO THIS: 

 

➢ Create a new Job called Training Pipeline Project. 

➢ Create a new Program called Pipeline Draft 

➢ Set the start date to 01 Jan 2019. 

HOW: 
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➢ In the Programme Manager, click on the New button. 

➢ In the Project Information dialog box, in the Start Date box, enter the start date as 01/01/2019. 

➢ Click OK to accept the start date. 

➢ Double click on the new program to open it up.  

 

STEP 2 - Adjust the Project Calendar 
 

DO THIS: 

➢ Add the 15 March 2019 holiday exception. 

➢ Add a new Manhole calendar for the manhole team who can only work Saturdays and Sundays. 

HOW: 

 

To select the project calendar 

1. Click on the Calendar Setup button. 

2. In the Calendar setup, click on the Tools tab and select Year Planner. 

 

To set a specific date as nonworking 

 

1. Once in the Year Planner, you can select the specific date and set it as a workday, weekend, 

non-workday or holiday. 

2. In our case, the 15 th of March is a holiday and hence, you can select this da te and click on the 

Set holiday button on the bottom right of the screen.  
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To create a unique calendar 

 

We know the manhole team can only work on weekends. Thus, we need to create a unique calendar 

for them. This is done in the Calendar Setup.  

 

➢ Once in the Calendar Setup, click on Tools. 

➢ Select Add Calendar.  

➢ Type in a Calendar code. In this case you can use MH for the Manhole Team.  

➢ Type in the Calendar name. In this case, you can call it Manhole Team.  

➢ Click on OK. 

➢ Move your cursor to the newly created MH Calendar and click on any line within the MH column. 

➢ You will now be editing this new Calendar.  

➢ With your cursor in the MH column, click on Tools and select Workday pattern.  

➢ Untick all the weekdays and tick the Saturday and Sunday box.  

➢ Click on the green Checkmark to save the selection and click Yes thereafter. 

You will now see the MH calendar changed to show weekdays as non-working and weekends as 

working days. 

 

Tip. Set up a blank project file with your countries holidays and keep this as a Calendar  template. For 

each new project, recover the file into a new program and start your scheduling on this already 

populated Calendar . 

 

STEP 3 – Setting up your WBS 
 
A well-thought-out works breakdown structure (WBS) is what separates good planners and project  

managers from great ones. A WBS essentially distributes a project’s total work into smaller batches or 

work packages. Your schedule’s level of detail is mainly determined by the WBS. Take your time to 

develop a WBS before you start scheduling. There is no  rule-of-thumb on how to develop a WBS as it 

will differ from project to project based on the numerous unique variables and factors of each project. 

It takes a bit of time and experience to develop an understanding of the different ways in which you 

can structure various projects. Let me share with you my thought-process in developing a WBS on our 

case study project. 
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My project’s first level is the execution phase. I chose to divide my project into 6 main work packages 

on level 2. Each one is a portion of work that is separable in trade and can be managed by a separate 

team on site in a specific area. I could have included the manholes as part of the laying of pipes work 

package, but chose to create a separate heading/package as  it will be done by a subcontractor and 

hence, by having a work package separately we can plan and track it in isolat ion of the pipe laying 

work. If you prefer to rather include it in your pipe laying work package, that would’ve been quite 

acceptable. I then decided to divide my Lay Pipe work package into 2 separate work packages. Section 

0 – 200 and 200 – 2200. The reason for this is that these sections can be tested as a whole between 

two manholes. Lastly, I decided to divide the large section (200 -2200) into 200m sections. The reason 

for this is to have more control in my schedule. More detail means more control, less detail is less 

work, but then we have less control.  Can you see how my WBS develop ment is guided by my personal 

management preference, my technical know-how, practical considerations, and my desired level of 

detail? 

 

Tip: If you are a young scheduler, spend a lot of time with an experienced practitioner and see if you 

can understand their thinking in terms of how they plan to execute the wor k. Once you start tracking, 

you will quickly learn where you could have made better WBS choices. Make notes and learn  so that 

your next WBS is better prepared. 

 

 
DO THIS: 

 

Use the following WBS and set it up in Candy using summary tasks. 

Execution Phase

Milestone 
Dates

Establish on 
site

Lay Pipe 
Sections

Lay Pipe Section 
200 - 2200

Lay Section 200-
400

Lay Section 400-600

Lay Section 600-800

Lay Pipe Section 
0-200

New Pump 
Room

Install 
Manholes

Final Connections/ 
Commissioning
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Once completed it should look like this:  

 

 

STEP 4 - Add the project’s key milestones. 
 

It helps to create a milestone list early on. This list should contain all contractually significant dates 

and at the minimum must contain a contractual start date and a contractual end date.  It helps to 

delineate your schedule’s allowed duration from the onset.  

 

DO THIS: 

 

Add the following milestones under the Milestones summary: 

 

Execution Phase

Milestone 
Dates

Establish on 
site

Lay Pipe 
Sections

Lay Pipe Section 
200 - 2200

Lay Section 200-
400

Lay Section 400-600

Lay Section 600-800

Lay Pipe Section 
0-200

New Pump 
Room

Install 
Manholes

Final Connections/ 
Commissioning
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STEP 5 - Add tasks under each WBS work package 
 
DO THIS: 

 

Add the following tasks to each WBS summary:  

 

To add activities to your schedule: 

➢ open up the Activity/Barhart view from you Document Manager.   

➢ insert lines below the heading level of your choice by using the CTRL + INS shortcut. 

➢ Click in the Description Column and start typing the activity names as follows:  

 

STEP 6 - Add task durations. 
 

DO THIS: 

 

Add the following durations to tasks: 

 

• ESTABLISH    = 5 days 

• SETTING OUT   = 2 days 

• EXCAVATE     = 128m3   at a rate of about 32m3/day= 4 days 

• BEDDING    = 24m3   at a rate of about 24m3/day= 1 day 

• LAY PIPES    = 200m of pipe at a rate of 100m/day = 2 days 

• TEST BEFORE BACKFILL  = 200m/day = 1 day 

• BACKFILL AND COMPACT  = 104m3   at a rate of about 52m3/day= 2 days 

 

STEP 7 - Add logic / interdependencies 
 

DO THIS: 

 

Use any of the methods you prefer and link the activities in a logic al sequence Finish to Start. 

 

1. Excavate for pipe trench 

2. Bedding to pipe trench 

3. Lay pipes 

4. Testing before backfill 

5. Backfill and compact 
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STEP 8 - Add Resources 
 

DO THIS: 

 

The following resources will be used to lay the pipe sections on site. Create these resources in your 

Resource Definitions sheet Candy as follows and then assign them as shown:  
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Assignment 1 
 

If you want to earn the certificate of completion, ensure that you complete the steps up to Step 8. 

Thereafter, make a backup of your program file and send it to me at training@lerouxconsulting.com.  

 

 

Review the final schedule 
 

Follow the video lesson to see how the final schedule is compiled. We will be using this schedule going 

forward.   
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MODULE 5 – Advanced Techniques and Skills to manage your Schedule 
 

Module 5 Lesson 1 – Most important task/summary interactions and shortcuts. 
 

This lesson will focus on the most important shortcuts and introduce you to a range  of task 

interactions you may want to perform such as shifting tasks or WBS summaries around, copying and 

pasting task, renumbering activities, and the like.  

We have Recovered the attached file “01 Pipeline Project Example Before Baseline.CCS” into a 

new program in Module 4. If you haven’t done so, do it now as we will be working on this progr am 

going forward.  

 

Follow the video Module 5 Lesson 1 showing you the detailed steps of interacting with your tasks.  

 

Summary of the most important shortcut keys: 

 

Copy an activity or summary line: 

 

 

Paste an activity or summary line: 

 

 

Inserting a blank line.. (remember it inserts a line above where your cursor are): 

 

 

Deleting a task or closed summary: 

 

 

Closing a summary: 

 

 

Opening a summary: 
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Shifting a task or summary downwards: 

 

 

Shifting a task or summary upwards: 

 

 

Duplicating the information/data in a cell right above your cursor: 
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Module 5 Lesson 2 – Constraints, task types and project outline level navigation.  
 

To view the different outline levels: 

1. Right click on any WBS summary’s minus or plus sign on the left-hand side of the programme. 

2. Or go to View and View level to show the same. 

 

3. Select the various options of either opening all levels or closing levels up to a specific level.  

 

To check the level hierarchy: 

4. Click on View. 

5. Select the Check level hierarchy button.  
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The activity types: 

 
1. Click in any record in the “T” column to bring up the following options for task types in Candy:   

 

 
 

 

Module 5 Lesson 3 - Using Filters 
 

• Let’s say we have a concrete supplier who needs to co-ordinate each concrete pour on this 

project.  We need to show them our initial plan for concrete pours and then keep them 

updated on a weekly basis on how progress develops and how these dates are influenced by 

our progress or; 

• We may want to review which tasks fall within a certain date range or; 

• We may want to review only the critical tasks, or only tasks using a certain resource. 

 

The truth is that it is very difficult to manage or control any schedule without having the ability to filter 

and make sense of the massive amount of data that sometimes comprise the programme.  Be 

reminded that our example is quite small, we often work with schedules containing no less than 

16,000 tasks. We cannot make sense of it without the filter function. 

 

Using the filter function 

 

1. Go to your Gantt Chart View and make sure you show all subtasks. 

2. On the View Tab, click on the Filter dropdown. 

3. There are a number of built-in filters.   

4. Let’s do a filter for all critical tasks. 
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5. Click on the filter drop-down and select the Critical filter in the dropdown. 

 

The result is that all critical tasks are filtered as below: 

 

To clear a filter, do the following 

 

1. In the Filter Toolbar 

2. Click on the Abandon button. 

 

 

 

Module 5 Lesson 4 – Adding Timelines and changing Barchart display options. 
 

A great function of Candy is the ability to add visual lines on the Barchart  window and in your reports. 

These lines can depict major stages, milestones or phases in the project. Remember they are purely 

visual aids and they don’t form part of the measurable tasks or logical sequence of your schedule  in 

any way.  

 

To add timelines 

 

1. Click on the planning and definitions button -   

2. Go to the Timeline/definitions tab 

3. On the right-hand side, add your timeline descript ion and date in the any of the record lines. 

4. Click on OK 
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To change barchart display options  

 

1. Click on the Barchart menu item above your table 
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2. Go to options 

 

In the options dialog, you can decide to show or hide headings, links, end and start ar rows as well as 

Timelines.  You can decide to show float and decide what fields you would like to display next to your 

tasks. You can also tweak your Bar appearance and decide how you want to display gridlines.  

 

Have a look below: 

 

 

 

 

Module 5 Lesson 5 – Implementing notes, remarks, or yellow tags 
 

 

Candy provides us with a few options for adding notes to our schedule.  These options are: 

 

➢ Activity Remark and Activity Notes 

➢ Progress Remark and Progress Notes 

➢ Yellow Tags 

The following diagram explains how the different options is displayed when we print a report.  We can 

choose to switch these notes on or off in our reporting. 
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Adding notes and remarks: 

➢ Go to the Record Selector Menu by right-clicking in the record block next to the activity  you 

want to add notes to. 

➢ Select Notes and Remarks 

➢ Alternatively, you can add Columns for these notes into you view and edit them from there. 

 

 

Yellow Tag Activity Remark 

Activity Note 

Progress Remark 

Progress Note 
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Module 5 Lesson 6 – Creating and allocating task codes. 
 

Codes are used to make your life much easier when fil tering.  It is sometimes difficult to apply a filter 

to unrelated activities or activities that don’t share any common text in description.  This is where codes 

enable us to quickly filter those groups of tasks, once the codes are allocated.  

 

Let’s say we want to filter either our pump room or the pipe section in our programme. Doing either will 

be difficult without allocating a unique code to each group.  

 

Creating Codes 

 

To create codes and definitions, click on the Planning Definitions and Setting  icon: 

  

 

 

 

Allocating Codes 

 

➢ Use the Record Selector Menu to allocate Codes. 

➢ Alternatively, open the Code columns in your Document Manager  and type or insert codes next 

to activities. 

Only one code can 

be assigned per 

activity 

Multiple codes per 

activity can be 

assigned 
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MODULE 6 – Reporting 
 

Module 6 Lesson 1 – Reporting basics 
 

Reports are created in the Report Manager. 

 

 

Similar to the Document Manager, the Report Manager allows us to choose and customise different 

views, layouts and settings for printing our Barcharts.  

 

Once opened, we are presented with a screen similar to the Document Manager where we can 

customise, create new or duplicate reports.  
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Create a new report. 

➢ Once you are in the Report Manager, click on the New Report button. 

➢ Select Standard Barchart.  

➢ Rename the report Initial Baseline Report 

➢ Click on the Customise Report button. 
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Follow in the video as we cycle through the different tabs to adjust and set up a basic report. 

 

1. Go to your Gantt Chart View and make sure you show all subtasks.  

2. On the View Tab, click on the Filter dropdown. 

3. Select New Filter 

4. The following information box opens up: 

 

Module 6 Lesson 2 – Histograms  
 

In this lesson we are going to create resource histograms. We will be using the exact same principles 

as per the previous lesson in the Report Manager.  Follow in the video and see how we can produce 

the following reports: 

 

TABS 
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Module 6 Lesson 3 – Advanced Reporting Techniques 
 

In this lesson we are going to create some advanced reports by using a combination of techniques 

that we’ve learned up to now. Follow in the video and see how we can produce the following reports: 

 

Two-week lookahead report: 

 

 

High-level Summary Report 
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Exporting a report into Excel 

 

1. Go to your Report Manager 

2. Select any of the reports in the list 

3. Click on the arrow button next to the Print report button as shown below 

 

 

 

4. This will open a dialog with some alternative printing options: 

 

 

5. Select Write to Excel File.  

6. Select the folder you want to save to and c lick on Save File. 
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7. Once saved, you can view the file by navigating to the selected folder. Or if you selected the 

View file afterwards option, the file will automatically open in Excel showing your data export.   

 

MODULE 7 – Adding Long Lead and Info Required 
 

Module 7 Lesson 1 and 2 – Creating a Long Lead Schedule in Candy. 
 

A common error many contractors make is to forget about the le ad times for major sections of work or 

the process to enable an installation to commence. Major items of equipment can take months to be 

delivered to site. Steel structures for instance, require a process of shop drawing design, approvals, 

order placement, manufacturing, and a lead time for delivery before installation can start.  A properly 

conceived programme should clearly indicate all these stages and “behind the scenes” work required 

to commence a task on the programme. 

 

This is where the Long Lead schedule function of Candy becomes helpful. It ’s a separate module where 

you can add these behind the scenes tasks and link them to drive the start date of tasks in your 

schedule. 

 

To create a long lead schedule, use the following steps:  

➢ Identify the Long Lead activities in your schedule 

➢ Open the LL schedule and create a new schedule 

 

➢ Type in the Activity nr of all long lead Activities.   

➢ In this instance, let’s use the first task where our pipe material will be required as well as the 

pump installation tasks as our two long lead activities. 

➢ This is task A180 and A450. 

➢ In the Long Lead schedule window, Enter the task nr A180 in the Act# column as below. 

➢ This will automatically import the task’s information from the programme, into the LL schedule.  

 

 

➢ This will automatically import the task’s information from the programme, into the LL schedule.  

➢ Below the task in your LL schedule, you can start typing each step required and its respective 

duration, before this task A180 and A450 can start on site. See below an example: 
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➢ Candy will automatically calculate the dates of each step to complete one day before the 

activity’s start date on site. 

 

 

 

Once Long Leads are added, we can use the print function in the LL schedule to do a quick print-out 

as below: 
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The next step is to export these long leads back into our programme, so that they interact with our 

program activities and to enable us to print report s where the long leads are shown on the Barchart.  

 

➢ Firstly, ensure that you calculate using the Baseline dates. To do this, click on the arrow next 

to your calculate button to select this option. 

 

➢ Thereafter, click on the Tools item in the menu bar.  

➢ Select Export to program and follow the prompts.  

 

 

Once exported, the following report can be generated in the Reporting manager: 
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Module 7 Lesson 3 – Creating an Information Required Schedule in Candy. 
 

In this example, we are going to use another technique to import activities i nto our IS schedule.  Instead 

of typing the codes, we can import selected or all  activities in our program.  Let’s create an information 

required schedule for reinforc ing: 

➢ Identify the Reinforcing activities in your program by doing a filter.  

➢ Open the IS schedule and create a new schedule 

 

➢ Click on the Tools  menu.  

➢ Go to Import from program 

➢ Select Import all activities 

 

  

 

➢ Once imported, find the reinforcing to slab and paint tasks.  

➢ Insert blank rows below each task  

➢ Insert the Information required information below each tasks and add the duration of lead time 

in the Durn column.  

➢ The Required date will automatically be calculated. 
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MODULE 8 – Updating and tracking progress 
 

Module 8 Lesson 1 Update setup and introduction 
 

CCS Candy is a powerful scheduling tool that helps us to track, control and adjust our schedul e as 

work progress. Without updates and tracking, we cannot harness Candy’s scheduling power. 

An update should be done systematically, and the following steps should apply for each update. 

1. Ensure that you make a duplicate of your programme to ensure that a separate record or 

candy file exists for each and every update. 

2. Ensure the baseline is set. In Candy, you cannot do an update without having a set baseline.  
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3. Set the Timenow line. Also known as the Status Date or Data Date.  

4. Perform the actual information input.  

5. Review the actual vs planned and report on variances.   

 

Module 8 Lesson 2 Set the Baseline and update preparation 
 

The baseline is essentially a snapshot of your initial planned dates, duration and sequence. When we 

enter progress information, it measures our actual performance against this planned snapshot, so 

that we can establish and review any variances between planned and actual.  The baseline provides 

an effective visual on this variance and helps us keep track of our agreed/original plan.  

 

To set the baseline: 

 

➢ Click on the Progress and Timenow icon:  

 

 

 

➢ Click on the Base Program button and follow the prompts. 

 

 

 

➢ Once set, you can click on the Progress menu in the program window menu bar and select 

Show base bars. 
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➢ When the Show base bars option is selected, the baseline will be displayed on your Barchart 

window by the blue bars as shown below: 

 

 

 

To set your own unique view for the updates: 

 

➢ Click on the Document Manager Icon: 

 

➢ Right click on the Standard Barchar t document and select duplicate.  

➢ Right click on the duplicated document you just created and rename it to My Update View 

➢ While selected, click on the customise document button 

➢ Add the Actual Start, Actual Finish, Remaining duration and % complete fields to your view as 

shown below: 
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➢ Click on OK. 

➢ Double click on the My Update View document to open up the view. 

 

You can now switch to this view in future when doing updates. 

 

Module 8 Lesson 3 Performing the update 
 

 

Remember to make a duplicate of your baseline and rename it to Update 31 Jan 2019. 

 

To set the status date: 

 

➢ Click on the Progress and Timenow icon: 

 

 

 

This will open the following screen: 
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➢ Select the 31st of Jan 2019 as our first update status date or TimeNow date. 

 

Different ways to add progress information to your schedule: 

 

Option 1 – Using the mouse. 

 

 

Option 2 – Using the Barchart menu 
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Option 3 – Using the Barchart Update buttons 

 

 

 

 

Option 4 – Entering information manually by using an update view  

 

 

 

➢ Use any of the techniques and enter the following progress information into the barchart. 
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o All the work up section 400 has been completed as planned. 

o The excavation on the pipe trench in section 400-600 took 2 days longer and only 

finished on 29 Jan 2019. 

o No other tasks on the pipeline section commenced. 

o On the pumproom building, all work progressed as planned.  

o Task A350, cast concrete in plinth, has started but it is estimated that the task will not 

complete for another 3 days. Hence, the remaining duration should be adjusted to 3 

days.  

o All work on the manholes progressed as planned. 

o Once completed, your update should look like this: 
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Module 8 Lesson 4 Review the update and isolate variances and delays. 
 

To review your schedule after an update: 

 

➢ Add the total float and current slip columns to your view 

➢ Remember that where total float is negative, it denotes a delay to our completion date. Where 

current slip is negative it simply indicates a delay to the baseline. The dis tinction between the 

definitions is extremely important. We have to keep an eye on slip because it may lead to 

production problems later on, however, negative float is an indication of critical delays.  As a 

result, we would like to isolate and report on critical delays. 

➢ Have a look at your completion milestone and its float. If it is -4, it means that your schedule is 

delayed by 4 days. We want to investigate and see where this 4-day delay comes from. 

➢ On the progressed activities, follow the critical path tasks and notice where current slip is 

negative. Try and find the first instance and thereafter find the task where the current slip 

changes. This would denote tasks that were delayed, and which delay impacted the complet ion 

date. 

➢ In our example, task A540 is the first critical task with a negative slip of -2. It means this task 

was delayed for 2 days, and that delay contributed 2 days to our current 4-day delay. 

➢ Go to the record selector menu of that task, select it, right-click and go to Notes and Remarks 

➢ Add progress notes to the task to explain the delay  

 

 

➢ Scroll down the list of tasks and find the next critical task where the slip increases. Remember 

there may be tasks with float that is also delayed, and they will also show a slip increase. But 

because they have float, they will not impact the completion date yet. Hence, we are only looking 

to find critical impacted delays for now.  The next such task is A600.  Slip increased from -2 to 
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-4.  This task also slipped by 2 days.  It is therefore the combined 2-day slip of task A540 and 

the 2-day slip of task A600 that contributes to the total float of -4.  

➢ Make a progress note on task A600 as well. 

➢ We have now isolated the reasons for our 4-day delay. 

 

 

 

Module 8 Lesson 5 Update LL and information required schedules. 
 

Update the LL schedule: 

 

➢ Ensure you make a duplicate of your updated programme, before upda ting LL or IR schedules. 

➢ Open the First Long Lead schedule. 

➢ Add the actual date on which you received the pump specification – in this case 31/01/2019. 

➢ The effect will automatically show as -3, meaning this information is 3 days late. 
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➢ Calculate the LL Schedule. 

➢ Export the data back into the program. 

 

 

 

➢ This will create an Imposed Delay on the task, based on the actual delivery of the pump 

specification  

 

 

➢ The following report can now be produced (follow in the video), showing the impact of LL delays: 
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Module 8 Lesson 6 Reporting on the update. 
 

Once you understand the various methods and techniques of structuring your columns, filtering, coding and 

highlighting information in your schedule, you can create an unimaginable amount of different reports. I will show 

you some examples of the most informative reports I prefer to use after an update. 

 

To report on the schedule after an update: 

 

➢ Create standardised and personalised reports for your update in the report manager. 

➢ We will create a separate “Updates” heading and create the following reports : 

 

➢ In the Report Manager > Create a new heading called Updates > Duplicate the Standard 

Barchart and move it down to the new heading. 

➢ Rename the report > Detailed Update Report.  

➢ Select the Customise report button. 

➢ Adjust your settings and styles to your lik ing 

➢ Add the following columns to your report -  
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➢ The preview should look something like this: 
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➢ Once printed, duplicate this report and rename it to the High Level Update Report. 

➢ Customise this report to show a high-level of detail as follows (follow in the video for the exact 

steps): 

 

➢ Once printed, duplicate this report and rename it to the Dominant Delay Report.  

➢ To do this report, we will first need to perform a complex filter.   

➢ Exit the Report Manager for now. 

➢ Open the float and progress remark columns in your current document view. 

➢ Select the progress remark column and, right click and go to filter > select Filter for blanks. 
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➢ Thereafter, we need to invert the filter as we actually want to show only those tasks where the 

progress remark column is not blank. 

 

➢ Click on the Float column and  > Select all records. 

 

➢ Click on the + sign in the Filter Toolbar and select the option > Increase by adding … > at the 

bottom include all occurrences of Equal to -4.  Save the selection. 

 

➢ If done correctly, you should now have a filter showing all critical delays  on completed tasks 

and a forward looking filter only showing the chain of impacted tasks up to the completion date. 

➢ With this filter employed, go back to the Report manager and customise the Dominant Delay 

Report.  

➢ Go to the Documentation tab and select to show the following: 
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➢ The report should look like this when previewed or printed:  

 

 

Assignment 2 
 

If you want to earn the certificate of completion, ensure that you complete the update as outlined above. 

Thereafter, make a backup of your program file and send it to me at training@lerouxconsulting.com.  

 

 

 

oooOOOooo 


